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1 IMPORTANT INFORMATION 

For your protection, carefully read these instructions before installing and operating the scan 

head.  

Retain these instructions for future reference.  

Novant reserves the right to update this user manual at any time without prior notification.  

If product ownership changes, this manual should accompany the product. 

1.1 SAFETY SYMBOLS 

This manual uses the following symbols and signal words for information of importance. 

 DANGER 

Indicates a hazardous situation which, if not avoided, will result in serious injury or death. 

 

 WARNING 

Indicates a hazardous situation which, if not avoided, could result in serious injury or death. 

 

 CAUTION 

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury. 

 

 IMPORTANT 

Indicates information considered important but not directly hazard related (e.g. security, hygiene, 

or equipment or property damage). 
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1.2 SAFETY LABELS 

 DANGER  

Laser radiation  

can cause severe retinal and corneal burns, burns on the skin, and may pose a fire risk.  

• To avoid injury and reduce risk of fire, please follow the control measures and safety 

guidelines provided by the laser’s manufacturer, and those established by your Laser Safety 

Officer (LSO), Radiation Safety Officer (RSO), or safety department of your business or 

institution. 

 

 

 ESD WARNING 

Electrostatic discharge and improper handling  

can damage MOVIA scan head’s electronics. 

• Keep the equipment sealed until it is located at a proper static control station. 

 

1.3 CUSTOMER SUPPORT 

Before contacting Novanta for assistance, review appropriate sections in the manual that may 

answer your questions.  

After consulting this manual, please contact one of our worldwide offices between 9 AM and 5 PM 

local time. 

Americas, Asia Pacific 

Novanta Headquarters, Bedford, USA 

Phone: +1-781-266-5700 

Email: photonics@novanta.com 

mailto:photonics@novanta.com
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Europe, Middle East, Africa 

Novanta Europe GmbH, Wackersdorf, Germany 

Phone: +49 9431 7984-0 

Email: photonics@novanta.com 

Milan, Italy 

Phone: +39-039-793-710 

Email: photonics@novanta.com 

China 

Novanta Sales & Service Office, Shenzhen, China 

Phone: +86-755-8280-5395 

Email: photonics.china@novanta.com 

Novanta Sales & Service Office, Suzhou, China 

Phone: +86-512-6283-7080 

Email: photonics.china@novanta.com 

Japan 

Novanta Service & Sales Office, Tokyo, Japan 

Phone: +81-3-5753-2460 

Email: photonics.japan@novanta.com 

 

 

mailto:photonics@novanta.com
mailto:photonics@novanta.com
mailto:photonics.china@novanta.com
mailto:photonics.china@novanta.com
mailto:photonics.japan@novanta.com
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2 INTRODUCTION 

 

2.1 GENERAL NOTES 

Novanta reserves the right to make changes to the products covered in this manual to improve 

performance, reliability or manufacturability. 

Although every effort has been made to ensure accuracy of the information contained in this 

manual, Novant assumes no responsibility for inadvertent errors. Contents of the manual are subject 

to change without notice. 

2.2 USING THIS MANUAL 

2.2.1 Purpose 

The aim of this manual is to provide a brief description of the ScanMaster™ Designer software and its 

functions. This document will mainly focus on the 3D laser marking processes and the capabilities of 

ScanMaster™ Designer software to do surface marking and engraving processes. Furthermore this 

document will guide you through a three step process to achieve the final 3D laser marking. You will 

learn the options to create a 3D model, modify as desired and then to perform the process. The 

features of this application will be demonstrated using simple scenarios which will be helpful for you 

to understand the process more effectively. You will also find some main points that you should 

remember when managing a 3D laser marking project in ScanMaster™ Designer software. 

 

Note:  To understand this application and its features perfectly you are required to have a general 

knowledge about the ScanMaster™ Designer 2D application. 
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2.2.2 Document Conventions 

This document uses the following typographical conventions to present command line syntax and 

data file formats. 

 

Convention Description 

Command Object 
Words in bold formatting indicate commands, features or shortcut names 

appearing exactly as shown in the application. 

 

 

2.2.3 Revision History 

The following table shows the revision history for this document. 

Table 1 - Revision History 

REVISION DATE Changes from previous revision 

A October 1, 2014 First publication of this manual per ECO 8250 

B June 26, 2015 
Increased permissible cooling air pressure to 2 PSIG per ECO 

8639. 

C August 8, 2016 
Corrected error in Figure 44 and added note on cooling water 

(pg. 44) 

 

2.3 OBTAINING TECHNICAL ASSISTANCE 

If you encounter a problem refer to section “1.3 Customer Support” on page 2. 
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2.4 WARRANTY INFORMATION 

The Customer shall examine each shipment within 10 days of receipt and inform Novanta of any 

shortage or damage. If no discrepancies are reported, the shipment will be considered as delivered 

complete and defect-free. Novant warranties products against defects up to 1 year from 

manufacture date, barring unauthorized modifications or misuse. Repaired product is warrantied for 

90 days after the repair is made, or one year after manufacture date - whichever is longer.  

Contact Customer Service at +1-781-266-5700 to obtain a Return Materials Authorization (RMA) 

number before returning any product for repair.  

All orders are subject to the Terms and Conditions and Limited Warranty. Contact your local sales 

office for the latest version of these documents and other useful information. 

Customers assume all responsibility for maintaining a laser-safe working environment. OEM 

customers must assume all responsibility for CDRH (Center for Devices and Radiological Health) 

certification. 
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3 SAFETY     

Please read all operating instructions completely before installing and using a 3-Axis scanning 

system. 

3.1 SAFETY LABELS AND SYMBOLS 

The following safety labels and symbols are used throughout the system documentation: 

Table 2 - Safety Labels and Symbols 

Label Meaning 

 

Serious bodily injury or death 

 Potential for serious bodily injury 

 Potential for property damage and/or minor bodily injury 

 
SHOCK HAZARD—Electrical voltage is present. 

Take appropriate measures to protect yourself from electrical shock. 

 LASER HAZARD 
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3.2 GENERAL SAFETY GUIDELINES 

Laser Radiation 

Do not stare directly into a laser beam. 

Follow all system laser safety requirements during installation and operation. 

 

 

Shutter Safety 

Where practical, Novanta recommends the use of an internal shutter mechanism 

to prevent unwarranted emission of laser radiation. If this is not possible, consult 

the laser vendor to design a proper safety shutter that, when activated, will 

eliminate all possibility of exposure exceeding Class 1 limits.  

The safety shutter should be located between the laser and the input aperture of the 3-Axis system. 

This is the user’s responsibility Use of controls, adjustments, or procedures other than those 

specified in this manual without consulting a competent safety professional may result in component 

damage, and/or exposure to potential hazards. Always follow established industrial safety practices 

when operating equipment.  

This system is designed to be operated in conjunction with a laser. Therefore, all applicable rules and 

regulations for safe operation of lasers must be known and applied when installing and operating the 

system. Since Novanta Inc. has no influence over the employed laser or the overall system, the 

customer is solely responsible for the laser safety of the entire system. 
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3.3 SAFETY/CAUTIONS 

  

 

Use of controls, adjustments, or procedures other than those specified in this 

manual, without consulting a competent safety professional, may result in 

component damage, and/or exposure to potential hazards. Always follow 

established industrial safety practices when operating equipment. 

 

Always check your application program BEFORE running it. Errors can cause 

system damage. 

 

Electronic boards are fragile! Handle and store with care. 

Protect electronic components from dust, humidity, electromagnetic fields, 

static electricity, chemicals, and mechanical stress. 

 

3.4 SYSTEM SAFETY 

 
To avoid damage to optics (such as lenses or mirrors), do not use a laser power setting 
that exceeds the laser power handling limit for each optic. 

3.4.1  Back-Reflections 

Any flat or curved surface (including protective windows) between scanning mirrors and the work 

field will have back-reflections where some percentage of the beam propagating toward the work 

field will reflect from this surface and will travel back towards the scanning system. Although, the 

absolute laser power of the backwards propagating beam may be low, the beam may come to a 
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focus on or close to a scanning system optic and the laser damage may occur due to the power 

density of the laser beam. It is the user’s responsibility to make sure that any back-reflections from 

any surface downstream of the scanning system is managed properly. 

3.4.2 Direct Laser Damage 

The power handling limits of mirrors and lenses can vary depending on laser parameters such as 

beam size, laser power, pulse duration, and pulse energy. It is the user’s responsibility to ensure 

that the laser parameters are appropriate for the exact scanning system that he or she is using. The 

standard warranty does not cover damage caused by laser power settings that are above the 

maximum limits for each optic. 

Please contact Novanta if you are not sure about the power limitations of your scanning system. 

3.5 ESD CAUTION 

 

ESD HAZARD! 

The electronics that Novanta manufactures—including the galvanometers and 

servo controllers in 3-Axis scanning systems—are electrostatic discharge (ESD) 

sensitive. Use appropriate anti-static wrist straps and/or work area equipment 

to prevent damage to the scanning system. 

 

Upon receiving your components, note that they are packaged in an ESD-protected container with 

the appropriate ESD warning labels. The equipment should remain sealed until it is in a proper static 

control station. 

• A proper static control station should include the following: 

• A soft grounded conductive tabletop or grounded conductive mat on the tabletop 

• A grounded wrist strap with the appropriate (1 Meg) series resistor connected to the 

tabletop mat and ground 

• An adequate earth ground connection such as a water pipe or AC ground 

• Conductive bags, trays, totes, racks, or other containers used for storage 

• Properly grounded power tools 

Personnel handling ESD items should wear ESD protective garments and ground straps. 
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NOTE:  Any equipment returned to the factory must be shipped in anti-static packaging. 
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4 PRODUCT INTRODUCTION 

 

4.1 WHAT IS LASER MARKING? 

3D laser marking refers to the laser marking performed on a 3D workspace. 3D laser marking 

comprises a range of 3D related processes including all types of Surface Markings, Engraving, Sub 

Layer Laser Engraving and Prototyping. 3D laser marking technology is widely used by many 

industries such as packaging, automobile manufacturing, jewelry and etc. 

ScanMaster™ Designer software allows you to create a digital 3D model and apply 2D images to a 3D 

surface.  This application facilitates 3D marking with either projection or wrapping styles. 

This application also enables you to do laser engravings by specifying different sections and layers. 

More detailed information about these features will be discussed in this document. 

The marking procedure can be customized using the ScanScript language in which you can 

experience the advanced capabilities not available through the user interface.  

 

Note:  A detailed description about Projection and Wrapping styles and their differences will be 

discussed in the appendix of this document. Refer Appendix A of this document. 

 

4.2 SCAN CONTROLLER CARDS 

There are four different Scan Control cards available which are supported by ScanMaster™ 

Designer software:  

1. ScanMaster Controller - The SMC is a self-contained controller that provides advanced 

hardware and software control technology to drive laser scanning systems. The Ethernet-
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connected SMC board is designed to permit remote embedding and control of a scan-head 

and laser system. It is capable of controlling two scan-heads with up to three motion axes 

each with concurrent laser timing control. It also provides integrated synchronization I/O for 

connection to factory automation equipment. 

2. EC1000 - The EC1000 is a self-contained controller that provides advanced hardware and 

software control technology to drive laser scanning systems. The EC1000 control board is 

specifically designed for remote embedding and control of a scan-head and laser system. It is 

capable of controlling two scan-heads with up to three motion axes each with concurrent 

laser timing control. It also provides integrated synchronization I/O for connection to factory 

automation equipment. The EC1000 controller card is the core of the SM1000 Controller 

Module. 
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5 GETTING STARTED 

Use information in this section to install and start the ScanMaster™ Designer software. This section 

will also introduce the key features of the program as well as recommended tips for establishing a 

good workflow.  

 

5.1 SYSTEM REQUIREMENTS 

The following software and hardware specifications are the minimum system requirements to install 

and run ScanMaster™ Designer software on your computer: 

• Processor: 1GHz  

• Memory: 1GB  

• Hard Disk Space: 1GB  

• Display: 1024 x 768 High Color (16-bit)  

• Windows XP Professional SP3 / Windows  Vista SP2 / Windows 7 SP1 
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5.2 STARTING SCANMASTER™ DESIGNER SOFTWARE 

To open ScanMaster™ Designer: 

1. Click Start on the taskbar. 

2. Select Programs and locate the CTI folder and then the ScanMaster™ Designer sub-

folder. 

3. Click the ScanMaster™ Designer  icon. 

The following window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 

1- START-
UP SCREEN 

 

To start a new project click New from the Home tab.  
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A basic marking job is created by placing different basic shapes such as a box, sphere, cone, or a 

cylinder on the canvas. Each 3D shape has its own unique properties which can be modified. See 

Error! Reference source not found. in this document, for detail information about creating projects. 

To exit ScanMaster™ Designer, click the Close button on the top right of the screen or select Exit 

from the ScanMaster™ Designer button. 

5.3 WORKSPACE ELEMENTS 

Before you can begin using the software you need to be familiar with the ScanMaster™ Designer user 

interface. Let’s start by taking a look at the main application window and how it’s laid out.  

 

FIGURE 2- WORKSPACE ELEMENTS 
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5.4 RECOMMENDED WORKFLOW 

The figure below shows the recommended workflow for ScanMaster™ Designer projects.  

  

FIGURE 3- RECOMMENDED WORKFLOW 

 

1. Create a 3D Model  

A “Job” is a simple program that contains Models, Processes and Scripts that are executed in the 

prescribed order. You might want to create a job to make a Surface Marking process or an Engraving 

process. The options in ScanMaster™ Designer software, allows you to do these tasks easily.  

 

Insert basic shapes to the drawing canvas by selecting any desired basic 3D shape from the Basic 

panel of the Modeling tab.  You can insert many shapes to create one 3D model.  

 

Note:  Refer Creating 3D Models to check detailed information on creating 3D models in a 3D project 

 

2. Edit the 3D Model 

 

After you have inserted shapes you can edit them as preferred. ScanMaster™ Designer software is 

equipped with a rich collection of editing tools which you can use to edit your 3D models. The 

options in the Modeling tab of the Ribbon will enable you to modify the 3D shapes according to your 

requirements.  

 



Getting Started 

1040-0009 Revision  

Note:  Refer Modifying 3D Models to check detailed information on how to modify 3D models 

 

3. Preparation of the 3D Process 

 

To prepare a 3D model to be processed on the laser marking, the commands in the Engraving tab 

and Surface Marking will enable you to set the specifications thereby preparing the model to be 

processed in order to achieve the output according to your requirements.  

Note:  Refer Preparation of 3D process to check detailed information on preparing the 3D model to 

be processed 
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6 SCANMASTER DESIGNER INTERFACE 

Across the top of the window is the Ribbon. All the application’s functions can be accessed from here 

and it’s the first place you should look if you’re new to the software and want to get an idea of what 

you can do with it. As your mouse passes over the menu, tool tips will be displayed.  

Each item is described in further detail in this section. 

6.1 THE RIBBON 

The Ribbon provides easy access to the ScanMaster™ Designer tools that can be used to create and 

edit 3D models. Tools are logically grouped into a collection of Tabs. Each tab contains multiple Groups, 

and each group contains a set of related commands. The Ribbon is docked on top of the ScanMaster™ 

Designer drawing canvas.  

6.1.1 Home 

The Home tab on the Ribbon contains the File, Edit, View, Processes and Canvas Style groups.  

 

FIGURE 3- HOME TAB 

6.1.2 File 

The File panel allows you to create new, open, save or import 3D and 2D files into the workspace.  

Icon Command Description 

 
New  Opens a new project  

 
Open  Opens a saved project  



ScanMaster Designer Interface 

1040-0009 Revision  

 
Save  Saves the current project  

 Save As  
Saves a new project or an existing project which is already opened, in a 

different name  

 
Export Disabled for 3D  

 

6.1.3 Edit  

The commands in this panel are designed to help you to delete, undo or redo the changes you make 

to the shapes inserted into the models. 

Icon Command  Description 

 
Paste Disabled for 3D 

 Cut Disabled for 3D 

 Copy Disabled for 3D 

 Delete Deletes all selected objects 

 Undo 

Reverse the last action performed. You may also undo the 
last few actions that were performed by clicking the arrow 
next to Undo 

 Redo Re-apply the actions that you undid last 

 

6.1.4 Veiw 

The options in this panel enable you to view the drawing canvas in different ways according to your 

requirement. 

Icon Command Description 

 
Zoom In Enlarges the display size of the workspace on the screen 

 
Zoom Out  Reduce the display size of the workspace on the screen  

 
Fit to All  

Adjust the zoom level to fit the entire contents of the drawing in to 

the current view  

 
Zoom Window  

Zoom Window offers a quick way to zoom a certain area of the 

drawing canvas 

 
Pan  

Panning allows you to quickly move around the canvas at the same 

magnification you have currently set  

 
Show Field  Resets the drawing canvas to the default viewing configurations 
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 Zoom Factor  
The Zoom Factor allows you to zoom in or out by the specified 

zoom factor  

 
Rotate  Rotates the drawing canvas  

 

6.1.5 Mark 

Icon Command  Description 

 
Start Start marking 

 
Pause Pause marking 

 
Stop Stop marking 

 Trace Trace the outer line of the drawing 

 Align Trace the bounding box of the current job 

 
Download 

Download scanning jobs to a flash memory in the card or 
to a USB memory 

 

 
Scan Project Scans the whole project including execution of the script 

 

6.1.6 Project 

 

FIGURE 5- PROJECT TAB 

6.1.7 Basic Elements 

Add new elements to the project. 

Icon Command Description 

 
2D Image Add new 2D Image to the project 

 
3D Model  Add new 3D model to the project 
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Script Add new script to the project 

 
Import Allows you to import 2D image, 3D model or script from file 

 

6.1.8 Marking Processes 

The Marking Processes panel gives you the options of the start of the 3D marking processes. 

Icon Command Description 

 

Surface 

Marking  
Creates a new surface marking process on the project  

 
Engraving Creates a new engraving process on the project 

 

6.1.9 Modeling 

The Modeling tab on the Ribbon enables you with many attractive options to modify the 3D shapes 

to create complex 3D models easily 

 

FIGURE 4- MODELING TAB 

6.1.10 Basic 

The Basic panel displays, the four basic 3D shapes to insert into the workspace which then you can 

modify them using the other options in the Modeling tab.  

Icon Command Description 

 
Box 

Inserts a three-dimensional cube on the drawing canvas according to the 

given width, height and length. 

 
Cylinder  Creates a cylindrical shape according to the given radius and height. 

 
Cone  

Inserts a cone shape according to the specified base and top radius and the 

height. 
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6.2 TRANSFORMATIONS 

The Transformations panel guides you on transforming the 3D shapes as required. 

 

6.2.1 Solid Operations 

The Solid Operations panel allows you to modify the 3D shapes in different ways.   

 

 
Sphere Inserts a sphere on the drawing canvas according to the defined radius 

Icon Command Description 

 
Rotate Rotates a shape around a specified axis on the canvas 

 
Scale  Changes the size of any object drawn or loaded to the canvas 

 
Mirror 

Creates a symmetrical mirror image of the selected shape according to 

the specified mirror axis 

 
Move  

Moves a shape to a new position you specify related to the current 

position 

 
Move to Origin  Moves the selected shape(s) to the origin of the canvas 

 
Aligning 

Aligns two or more objects’ bounding boxes to any of the given 

alignments  

 

Face Oriented 

Alignment 

Changes the alignment of a selected face so that it is oriented 

perpendicular to the given axis 

Icon Command Description 

 
Face Revolve 

Revolves the selected face of the object according to a specified x, y or 

z axis or arbitrary axis values.  

 
Face Extrusion  

Changes the dimension of an object by extending a selected face 

according to a specified extrusion length.    

 
Fillet Curves the shape of the selected mode, by a given radius 

 
Selection Mode Selects the 3D shapes by faces, edges, vertices or neutral.  
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6.2.2 Boolean Operations 

This panel allows you to modify two selected 3D shapes in terms of Cut, Fuse and Common. 

 

6.3 ENGRAVING 

The Engraving tab on the Ribbon provides you the capability to make adjustments to the 3D model 

for engraving.  

 

FIGURE 5- ENGRAVING TAB 

6.3.1 View 

The options in this panel enable you to view engraved objects in different views.  

 

 
Lighting  Changes the lighting effects from different directions.  

Icon Command Description 

 
Cut 

This command gives you the option of cutting a particular overlapped 

section of the first selected 3D shape  

 
Fuse  

The fuse command allows you to join two or more 3D objects together 

to make one particular 3D shapes 

 
Common Extracts the common section of two selected 3D shapes   

Icon Command Description 

 
Boundary Only   Allows you to view only boundary of the engraving object 

 
Hatch Only  Allows you to view only the hatch of the engraving object 

 

Boundary and 

Hatch   
Allows you to view both the boundary and hatch of the engraving object.   
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6.3.2 Engraving Simulation  

The options in this panel allow you to preview specified sections of your engraving process. 

 

6.4 SURFACEMARKING 

The SurfaceMarking tab on the Ribbon provides the capability to adjust the 3D model for surface 

marking.  

 

FIGURE 8- SURFACEMARKING TAB 

6.4.1 View 

The options in the Viewing Surface Marking Objects panel, provides different ways to visualize the 

3D model.  

 

6.4.2 Surface Marking 

Icon Command Description 

 
Start   Starts the preview of the engraving process 

 
Stop  Stops the preview of the engraving process 

Icon Command Description 

 

Shape and 

Mapped image   
Displays the 3D model and the mapped image 

 

Bounding Box 

and Shape  
Displays the 3D model and the bounding box of the mapped image 

 
3D Image only  Displays only the mapped image  

Icon Command Description 
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Add 2D Image  

This command allows you to add a 2D image to the canvas for 

processing 

 
Apply 

The Apply command allows you to apply the 2D image to your  3D model 

that you have created 
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7 LAYOUT OF 3D CANVAS 

7.1 DRAWING CANVAS 

The 3D drawing canvas is the 3D workspace which allows users to see the graphical representation of 

a 3D model and work with it.  

 

FIGURE 6- 3D DRAWING CANVAS 
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7.2 MARKING VOLUME  

The marking volume is indicated by a transparent pyramid shape. This represents the volume in which 

the scan head is capable of marking a given 3D point accurately.  

You can access the Marking Volume  button below the canvas. Click on the Marking Volume 

button to show/hide the marking volume. The following images show the appearance with and 

without Marking Volume. 

 

FIGURE 7- CANVAS WITH MARKING VOLUME 

 

FIGURE 8- CANVAS WITHOUT MARKING VOLUME 

 

Any 3D models or sections of 3D models which are placed beyond the marking volume will not be 

marked by the scan head.  
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7.2.1 Ruler  

Click on the Ruler button below the canvas to show/hide the ruler. The following images show 

the appearance with and without the ruler. 

 

FIGURE 9- CANVAS WITH RULER 

 

FIGURE 10- CANVAS WITHOUT RULER 

 

A ruler is displayed along the X and Y axis of the drawing canvas in order to help you adjust the 

position of the 3D model in the drawing canvas.  

The position of the 3D model can be specified by defining the X and Y values in the Properties of the 

3D model.  

7.2.2 Trihedral 

The trihedral  at the bottom left corner of the canvas indicates X, Y and Z axes of the grid which 

complies with a right handed Cartesian coordinate system.  

7.2.3 Grid  

The Grid options are accessible by clicking on the Grid  button below the canvas.  This 

command helps you to perfectly align shapes and drawings along the grid lines and points.  
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ScanMaster™ Designer software allows you to choose from three different grid styles. Select the 

desired grid option from the drop-down menu accessible by clicking on the Grid button. 

 The following images show the appearance of the different grid styles. 

 

FIGURE 11- BLANK GRID 

 

FIGURE 15- LINE GRID 

 

FIGURE 12- DOTTED GRID 
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7.3 VIEW ORIENTATION  

The View Orientation options are accessible by clicking on the View Orientation  button below 

the canvas. This command helps you to change the view of the drawing canvas in different 

directions.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 13- THE VIEWING ORIENTATIONS 

 

Note: The objects in the canvas will be displayed in the Isometric view by default 
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7.4 VISUAL STYLES  

The Shaded and Wire Frame options are accessible by clicking on the Visual Styles  button 

below the canvas. 

 

 

 

 

 

 

 

 

FIGURE 14- VISUAL STYLES 

 

7.5 PROJECT EXPLORER 

A project can have several 3D models and 2D images, marking 

processes and scripts. Any 2D image, 3D model, project or script 

created in the ScanMaster™ Designer software is visible on the 

Project Explorer tab, in a hierarchical structure. The current 

project is visible in the top level with corresponding 2D images, 

3D models, processes and the script files below it.  

To view the elements on the project explorer, click on the Project 

Explorer tab which is on the top-right corner of the application. 

 

 

 

FIGURE 19- PROJECT EXPLORER  
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The following table describes the commands and icons displayed in the Project Explorer tab. 

 

7.6 SHAPE TREE  

The Shape Tree displays all the shapes inserted on the current model or process. To access the shape 

tree, click on the Shape Tree tab which is on the top-right corner of the application. 

7.6.1 Hide/Show/Rename/Delete 

The shape  can be hidden, shown using the /  icons and rename or delete the shapes using the 

right-click options in the Shape Tree tab.  

1. Right-click on the particular shape from the Shape Tree 

2. You will see the menu as shown in the figure below 

 

 

 

 

 

 

 

 

 

FIGURE 15- SHAPE TREE RIGHT-CLICK MENU 

Icon Command Description 

 Delete  This command deletes any selected element in the project explorer  

 Move Up This command will move the selected item one step up in the current list  

 Move Down This command  will move the selected item one step down in the current list 

  
Project 

Settings  
This command allow you to customize the project settings  
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1. Click the Rename command to change the default name of the selected shape of the shape 

tree 

2. Click the Delete command to delete the selected shape from the project 
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8 MANAGING PROJECTS 

A clear understanding of 3D project management in ScanMaster™ Designer will ensure an efficient 

work flow.  This section guides you on certain basic areas which should be considered when 

managing a 3D project. 

8.1 BEFORE YOU BEGIN 

Before you create a new 3D project, you need to understand and focus on certain areas to gain 

optimal results: 

1. You should be familiar with the basics of ScanMaster™ Designer software interface. Refer 

Starting ScanMaster™ Designer Software and the Workspace Elements sections of this 

document to have a clear idea about the application. 

2. Get familiar with the supportive 3D file formats, project structure and the project default 

settings.  

3. You can import 3D models from STEP, IGES and STL formats.  

4. Understand the concept of changing the measurement units of the projects. The 

measurement units of the 3D models that you insert into your canvas depend on the 

settings of the Default Units and Grid Spacing that you set in Project Settings therefore 

make sure that you have an idea about your measurement settings when you specify the 

parameters of any 3D models in your project.  

 

Note: Please refer section 5 Managing Projects in the ScanMaster™ Designer 2D user manual to 

check more facts that you should consider before you begin a 2D project in ScanMaster™ Designer 

3D Extension. 

8.2 PREFERENCES 

Preferences are the project default settings for any new project created in ScanMaster™ Designer 

software. They are organized as General, Editors, 2D Scanning and 3D Scanning tabs.  
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The Preferences window is accessed by clicking the ScanMaster™ Designer  button on the 

upper-left corner of the screen. 

You will find the following Application Preferences window.  

 

FIGURE 16-  APPLICATION PREFERENCES 

 

8.3 CANVAS 3D COLORS 

The Designer Colors (3D) tab allows adjustment of  the colors of the 3D workspace. As seen in the 

figure below, the application allows you to customize the colors of the objects in the drawing canvas, 

the rulers, ruler text, marking area, marking area lines, upper and lower backgrounds, grid lines and 

the surface marking logo.  

To change the color of an element, click the drop down color chart button    and select the 

required color from either the preset colors or by means of the More Colors option, where you could 

specify RGB values to match a specific color.  
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1. Click the Use Defaults button to reset the colors to their original state 

2. Click on the OK button to save the changes you made to the colors of the layout and exit 

3. Click Cancel if you want to exit without saving 

8.4 GRID SPACING 

You can display the Grid as a rectangular pattern of lines or dots. The spacing between the grid lines 

is called "Grid spacing". Grid spacing can be measured in either millimeters or inches.  

 

Note: Refer the Chapter 5 Managing Projects of the 2D user manual for details on General, 2D 

Scanning and Editors| Designer Colors (2D) tabs. 

8.5 CREATING A NEW PROJECT  

8.5.1 To create a new project 

1. Choose New from the Home tab or press Ctrl + N. A new drawing canvas will be 
opened.  
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FIGURE 22- CREATING A NEW PROJECT 

8.5.2 To add 3D models to a project 

You may create several 3D model per project. 

2. Go to Project Ribbon tab.  

3. Click the 3D model   button on the Basic Elements group. A new 3D model will be added 

to the project and it will be visible on the Project Explorer window as well. 

Note: Refer to “Creating 3D Models” on this document to get more details on creating 3D models on 

your 3D project. 

• Refer the Chapter 5 Managing Projects of the 2D user manual for details on Opening, 
Saving a project.. 
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9 CREATING 3D MODELS 

The first step in the 3D model marking process is creating a 3D model. The ScanMaster™ Designer 

software allows you to create 3D models according to your requirements in different ways. You can 

create a 3D model from the beginning or you can import an existing 3D model to your project. 

9.1 CREATING A BLANK 3D MODEL  

To create a new 3D model of your own: 

1. Go to Project Ribbon tab.  

2. Click the 3D model   button on the Basic Elements group. A new 3D model will be 

added to the project and it will be visible on the Project Explorer window as well. 

 

A 3D model can be a collection of many 3D shapes. ScanMaster™ Designer software allows you to 

create any kind of 3D models using the basic 3D shapes provided to you.  

9.1.1 Inserting Basic 3D Shapes 

The ScanMaster™ Designer software comprises four basic 3D shapes including Box, Cylinder Cone 

and Sphere.  You can access these shapes in the Basic panel of the Modeling tab. Each shape can be 

inserted on to the drawing canvas by specifying the relevant geometrical parameters. 
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9.1.2 Inserting a Box  

To insert a 3D box shape, click on the Box command on the Basic panel. The figure below shows 

the specifications of the parameters associated with the box shape and its output.  

 

 

 

 

 

 

FIGURE 23- CREATE BOX  

 

1. The Base Point refers to the position of the Box on the drawing canvas. The base point is 

defined as the minimum X,Y and Z point of the box  

2.  The Length refers to the distance along the x axis 

3. The Width refers to the distance along the y axis  

4. The Height refers to the distance along the z axis 

5. Click OK to confirm your specifications 
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9.1.3 Inserting a Cylinder 

To insert a cylindrical shape select the Cylinder command on the Basic panel of the Modeling 

tab. The figure below shows the specifications of the parameters associated with the Cylinder shape 

and its output.  

 

 

 

 

 

 

FIGURE 24- INSERT CYLINDER 

 

1. The Center of Base Circle represented by the X, Y and Z coordinates refers to the center point 

of the base circle  

2. The Radius refers to the radius of the base circle 

3. The Height refers to the distance measured along the axis of the cylinder  
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9.1.4 Inserting a Cone  

To insert a cone shape to the drawing canvas, select the Cone command from the Basic panel.  

The figure below shows the specifications of the parameters associated with the Cone shape and its 

output. 

 

 

 

 

 

 

 

FIGURE 25- INSERT CONE 

1. The Center of Base Circle represented by the X, Y and Z coordinates refers to the center point 

of the base circle  

2. The Base Radius  refers to the radius of the base circle 

3. The Top Radius refers to the radius of the top circle 
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9.1.5 Inserting a Sphere 

To insert a sphere shape on the drawing canvas, select the Sphere command from the Basic 

panel. The figure below shows the specifications of the parameters associated with the Sphere and 

its output.  

 

FIGURE 26- INSERT SPHERE 

1. The Center represented by the X, Y and Z coordinates refers to the center point of the Sphere 

on the drawing canvas  

2. The Radius refers to the radius of the Sphere 

 

Note: You can create complex 3D models by inserting many 3D shapes and modifying them to make 

one whole 3D model. Refer Error! Reference source not found.  for more information on modifying 3

D models.  
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9.2 CREATE A 3D MODEL FROM AN EXISTING FILE  

ScanMaster™ Designer software allows you to import existing 3D models to your project.  

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 27- SELECT 3D FILE DIALOG 

 

1. Go to Project Ribbon tab.  

2. Select the 3D model   button from the import  drop down button. 

3. The 3D file dialog will be opened.  

4. Click Browse button to browse the existing 3D model file location. The Open dialog box will 

be displayed 

5. Select the desired 3D model file and click Open. The location of the file will be identified and 

displayed in the File Path  

6. The current width, height and length of  the 3D model will be identified automatically by the 

system 

7. If you want to change the width, height and length of the importing model, specify the values 

in the respective New Width, Height and Length fields 

8. Check the Move to Origin check box to move the importing 3D model to the origin of the 

canvas  

9. Click OK 
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9.2.1 Supportive Files  

ScanMaster™ Designer software supports the following file formats to be imported to the 3D 

projects.  

1. Standard for the Exchange of Product data (STEP) 

2. Initial Graphics Exchange Specification (IGES) 

STereo Lithography (STL) 

 

9.3 CREATING A 3D MODEL USING 2D SHAPES 

The ScanMaster™ Designer supports 2D shape extrusion to create 3D shapes. Any simple or composite 

closed shape can be extruded in the Z axis direction to form a 3D shape by simply specifying the height 

of the expected 3D shape. 

   

1. With a 3D model in place 

2. Select the desired 2D shape from the 2D canvas 

3. Right click on the selected shape and select Extrude from the pop up menu 

 

4. Specify the desired height for the extruded 3D shape 

5. Select the 3D model from the drop-down list, onto which this extruded shape adds. 
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You may use the multiple shape selection facility of the canvas either by drawing a selection box 

using the mouse or by selecting the required shapes while pressing the SHIFT button. Right click 

anywhere on the selected shapes to access the extrude menu. 

Note:  Only closed shapes or closed composite shapes are allowed. For example, any lines or open polylines will 

not be allowed. 
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10 MODIFYING 3D MODELS 

Once the 3D model is created, the next step is to modify the created models in order to create 

more complex 3D models and thereby achieve the desired output. This chapter will guide you 

through various modification features provided by ScanMaster™ Designer software.  

10.1 VIEWING OPTIONS  

The View panel in the Home tab provides a rich set of view port oriented operations.   You can 

change the view of the 3D canvas according to your requirements in order to help you navigate to 

each location of the model and observe it in detail.  

 

 

FIGURE 28- VIEW PANEL 

10.1.1 Zoom 

The Zoom commands are available in the Home | View section. Zoom commands are very useful 

when having to go back and forth between editing small details at a magnified level and for checking 

the overall picture at a minimized level. 

10.1.2 To Zoom In/ Zoom Out 

3. Go to the Home | View panel. 

4. Click Zoom In /Zoom Out , or select a more exact zoom percentage in the Zoom 

Factor percentage menu. 

5. Zoom In: Increases the magnification level of a drawing on the canvas. 
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6. Zoom Out: Reduces the magnification level of a drawing on the canvas. 

 

 

Note: You can also use the mouse wheel to increase or reduce the magnification level of the canvas. 

10.1.3 Zoom Window 

Zoom Window offers a quick way to view a certain area of the drawing.  

4. Click Zoom Window  

5. Select a certain area of the drawing 

10.1.4 Zoom Factor 

The Zoom Factor allows you to zoom in or out by the specified zoom factor. The default size is 

achieved by a 100% zoom factor.  

In the Zoom Factor box   type or select a zoom factor. 

10.1.5 Fit to All 

Fit to All allows resizing the drawing canvas width/height to display it in any screen size. 

6. Click Fit to All  

10.1.6 Pan 

Panning allows you to quickly move around the canvas at the same magnification you have currently 

set. 

1. Go to the Home | View panel 

2. Click Pan  

3. Click on the drawing canvas and drag it away to the location you desire and release 

Or 
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1. Click the middle mouse button 

2. Drag the cursor on the canvas and release the mouse when the drawing is at the 
position you desire. 

 

Note: The cursor image changes to a hand cursor when panning is activated. 

 

10.1.7 Show Field  

The Show Field command in the Home | View panel resets the drawing canvas to the default 

viewing configurations.  

1. Click on the Show Field  button to view the default viewing configurations of the drawing 

canvas. 

10.1.8 Rotate  

The Rotate function allows you to rotate the drawing canvas according to your requirements.  

1. Click on the Rotate  button on the View panel of the Home tab 

2. Click and drag on the drawing canvas to rotate into the desired angle 

 

10.2 TRANSFORMATIONS 

Transformation options can be accessed from the Transformations panel of the Modeling tab. This 

panel provides basic transformation options including rotation, scaling, mirroring, moving to the 

origin, moving to a desired location and face oriented aligning.  

 

 

 

 

FIGURE 29- TRANSFORMATIONS PANEL 
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10.2.1 Rotate  

You can use the Rotate command to rotate the 3D model around a specified X, Y and Z axis or an 

arbitrary axis and the angle. 

To rotate a 3D model select the appropriate model and click on the Rotate command on the 

Transformations panel.  

You can either specify the Standard Axis parameters or else specify the Arbitrary Axis parameters to 

rotate a 3D model  

10.2.2  Standard Axis  

1. To rotate a 3D model by specifying the standard axes select the desired axis and define an 

Angle to be rotated  

2. Click OK to confirm 

 

 

 

 

 

 

 

 

FIGURE 30- STANDARD AXIS 
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10.2.3  Arbitrary Axis  

Rotation by an Arbitrary Axis can be done in two ways. You can either select to rotate by defining a 

point and a vector or by defining two points on the 3D workspace.  

10.2.4 Point and a Vector 

1. To rotate by a point and a vector select the Point and Vector option from the Arbitrary Axis 

tab.  

2. Define the point by specifying the X, Y and Z values. 

3. Define the direction vector by specifying the I, J and K values.  

4. Define the rotation Angle  

5. Click OK  

 

 

 

 

 

 

 

FIGURE 31- POINT AND VECTOR 
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10.2.5  Two Points  

You can rotate 3D models by defining two 3D points as shown in the figure below.  

1. Define the first point by specifying the X, Y and Z values 

2. Define the second point by specifying the X2, Y2 and Z2 values  

 

 

 

 

 

 

 

FIGURE 32- TWO POINTS 

Note: Refer Appendix B for more details on specifying the arbitrary axes.      

10.2.6 Scale  

This function allows you to change the size of any 3D model on the canvas. To access the Scale 

command, click the Scale  button of the Transformations panel. You will see the following Scale 

dialog box.  

1. The Scale  button of the Transformations panel. You will see 

the following Scale dialog box.  

2. To scale a 3D model, select a 3D shape that you want scale 

3. Click the Scale  button from the Transformations panel 

4. Define scale factors for X, Y and Z directions in the appropriate 

text boxes 

5. Check the use same factors as in X check box to use the same 

scale factor given for the x direction for the other two directions 

also. Select the Base Point as required. The selected base 

point will be kept fixed while scaling . 
FIGURE 33- SCALING FACTORS 
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Note: The Scaling Factors should be greater than zero and if the value of the scale factor is 1 then 

there will be no change to the size of the object.  

10.2.7 Mirror 

This option will create a symmetrical mirror image of the selected 3D model according to the 

specified values in the Standard Axis or Arbitrary Axis tabs. You can access the Mirror  

command from the Transformations tab.  

1. Select the 3D model you want to mirror. 

2. Click the Mirror  command from the Transformations panel.  

3. Define the Standard Axis values on the Mirror dialog box or select 

the Arbitrary Axis tab to mirror with respect to an arbitrary axis. 

4. Select either Point Vector or Two Points options and define the 

respective values of the mirror axis.  

5. If you check Keep Original Object, the original 3D model will 

remain on the drawing canvas.  

10.2.8 Move   

This function allows you to move a 3D model relatively to a specified 

direction. The Move  command can be accessed from the 

Transformations panel.  

• To move a 3D shape select the 3D shape you want to move 

and click the Move command found on the 

Transformations panel 

• Specify the values of the X, Y and Z directions 

• Click OK to confirm 

The Delta X, Delta Y and Delta Z values represent the relative values of the move along the respective 

directions. 

FIGURE 34- MIRROR 

FIGURE 35- MOVE 
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10.2.9 Move to Origin  

This command in the Transformations panel allows you to the move the reference point of 

the 3D object to the origin. 

 

 

FIGURE 36- MOVE TO ORIGIN 
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10.2.10 Aligning 

This function allows you to align two or more objects by their bounding boxes according to any of the 

given alignments.  

You can access the Aligning command from the Transformations panel of the Modeling tab.  

 

 

 

 

 

 

 

 

 

FIGURE 37- ALIGNING 

To align the objects: 

1. Select the desired 3D objects you want to align 

2. Click on the drop-down arrow of the Aligning command to view the available alignment 

options 

3. Select a suitable alignment option from the Aligning list 
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The Center X Align function will align the center of the bounding boxes of the two selected shapes to 

the center X value of the first selected shape. 

 

a : Before Aligning 

 

b : After Aligning 

FIGURE 38- CENTER X ALIGN 

The Center Y Align function will align the center of the bounding boxes of the two selected shapes to 

the center Y value of the first selected shape. 

The Center Z Align function will align the center of the bounding boxes of the two selected shapes to 

the center Z value of the first selected shape.   

 

 

 

 

10.2.11 Face Oriented Alignment  

This function will change the orientation of the 3D shape in a way that the selected face will be 
turned to the specified direction.  

To change the face oriented alignment of a selected object click the Face Oriented Alignment  

command from the Transformations panel  
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You will find the following window as you click on the Face Oriented Alignment  command. 

 

 

 

 

 

 

 

 

 

FIGURE 39- ORIENT FACE 

1. To change the face oriented alignment you have to first select the Faces command from the 

Selection Mode list on the Solid Operations panel 

2. Select the 3D shape which you want change the face oriented alignment 

3. Select any of the face oriented alignment options from the Face Oriented Alignment list 

 

Note: For more details on Solid Operations panel refer the Solid Operations section in this document 
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10.3 BOOLEAN OPERATIONS  

Boolean Operations allows you to modify the 3D objects by cutting, fusing and extracting common 

areas of the 3D objects.  

 

FIGURE 40- BOOLEAN OPERATIONS  

 

The following Boolean Operations were done by inserting a Cylinder with a Height of 25 and a 

Radius of 10 and a Sphere with a Radius of 10 and Center Z as 25  

 

Note: When you perform any Boolean Operation the original shapes will become a single 3D object. 

The Shape Tree will display it as one shape as shown in the figure below. 

 

 

 

 

 

 

 

 

FIGURE 41- COMPOUND SHAPE ON SHAPE TREE 
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10.3.1 Cut  

The Cut  command gives you the option of cutting a particular overlapped section of the first 

selected 3D shape from the other selected 3D shape.  

You can access this command from the Boolean Operations panel of the Modeling tab.  

To cut an overlapped section of an object: 

1. Place the 3D shapes such that one shape overlaps the other 

2. Select the 3D shape that you want to modify. (Select the Cylinder) 

3. Select the other 3D shape that you use to cut. (Ctrl + click the object) 

4. After you have selected the two 3D shapes, click the Cut button on the Boolean Operations 

panel 

 

 

 

 

 

 

 

 

FIGURE 42- CUT SHAPE 
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10.3.2 Fuse  

The Fuse  command gives you the option of joining two 3D objects together to make a single 3D 

shape.  

You can access the Fuse command from the Boolean Operations panel of the Modeling tab.  

To fuse two 3D objects: 

1. Select the two 3D objects you want to fuse 

2. Click on the Fuse button on the Boolean Operations panel  

 

 

 

 

 

 

 

 

FIGURE 43- FUSE SHAPE 

10.3.3 Common  

The Common  command gives you the option to extract the common section of two selected 

3D shapes.  

You can access the Common command from the Boolean Operations panel.  

To extract the common section using the Common operation: 

1. Select the two 3D shapes 

2. Click the Common button on the Boolean Operations panel 

 

Note: ScanMaster™ Designer software allows you to select only two shapes at a time to make a 

Boolean Operation. 
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FIGURE 44- EXTRACTING THE COMMON PART OF THE TWO 3D SHAPES 

10.4 SOLID OPERATIONS 

You can do certain modifications to the basic 3D models using the options in Shape Operations panel 

in the Modeling tab.  

 

FIGURE 45- SOLID OPERATIONS 

Note: These functions will form compound shapes in the Shape Tree same like in Boolean Operations 
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10.4.1 Face Revolve  

Face revolving function allows you to revolve a face of a 3D object over an axis. The revolving axis 

can be defined by specifying the values on the Standard Axis or an Arbitrary axis tabs.   

To revolve a face of an object:  

1. Select the desired 3D object 

2. To change the Selection Mode to Faces selection mode to, click the Faces option from the 

Selection Mode  list of the Shape Operations panel 

3. Select the particular face you want to revolve 

4. Click on the preferred face of the3D object 

5. Click the Face Revolve  command on the Shape Operations panel 

6. You will find the Revolve dialog box as you see in the figure below 

7. Define the axis that you want revolve on the Standard Axis tab or select the Arbitrary Axis to 

revolve with respect to an arbitrary axis 

 

 

 

 

 

 

 

FIGURE 46- FACE REVOLVED BY A STANDARD AXIS 

1. Select either Point and Vector or Two Points options and define the respective values of 

the revolving axis 

2. Define the revolving angle in the Angle text box  

3. Click OK 
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10.4.2 Face Extrusion  

This function allows you to change the dimensions of an object by 

extending a selected face according to a specified extrusion length.    

You can access the Face Extrusion  command from the Shape 

Operations panel on the Modeling tab.  

To extrude a selected face of an object: 

1. First change the Selection Mode to Faces selection mode. Click the 

Faces option from the Selection Mode  list of the Shape 

Operations panel 

2. Select the particular face you want to extrude 

3. Click the Face Extrusion button on the Shape Operations panel 

4. Click on the particular face of the object and specify the length to be extruded on the given 

text box as shown in the figure 

5. You can also click and drag the mouse pointer on the selected face until you reach the 

desired length that you need to extrude as you see in the next figure. Click on the canvas 

after you reach the desired length  

 

 

 

 

 

 

 

 

 

 

 

FIGURE 48- DRAG TO THE DESIRED EXTRUSION LENGTH 

 

FIGURE 47- DEFINE THE EXTRUSION 

LENGTH 
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10.4.3 Fillet  

This function allows you to modify the edges of a selected 3D object.   

To fillet a 3D object: 

1. Change the Selection Mode according to your requirements 

2. Select the 3D object on which you want to perform the filleting operation 

3. Click the Fillet command 

4. Specify the fillet Radius on the Fillet dialog box  

 

 

 

 

FIGURE 49- FILLET 

 

 

 

 

 

 

 

 

FIGURE 50- FILLETS ON DIFFERENT SELECTION MODES 

The above figure shows how a Box with the dimensions of 12, 12, 12 will be modified according to its 

different selection modes when the Fillet command was used with a Radius of 5. 

 

Note: The Fillet function will not be applicable to the Vertices selection mode. 
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10.4.4 Selection Mode  

This command in the Solid Operations panel allows you to specify the selection mode. 

 

 

 

 

 

 

 

FIGURE 51- SELECTION MODE 

Note: Neutral mode is the default selection mode which enables the selection of whole 3D shapes. 

10.4.5 Lighting  

The Lighting command allows you to change the lighting effects of the 3D object on the 3D drawing 

canvas.  

Click on the Lighting button on the View panel of the Home tab. The following window will be 

displayed.  
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FIGURE 52- LIGHTING WINDOW 

10.4.6 Ambient Light 

Ambient Light  effect illuminates uniform light rays around the object from every direction.  

 

FIGURE 53- ILLUSTRATION OF AMBIENT LIGHT 

 

FIGURE 54- AMBIENT LIGHT 

Note: You can select any color of the light from the Color option in the Parameters Panel. 
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10.4.7 Directional Light 

Directional Light    emits light rays from a particular defined direction.  

 

 

 

 

 

FIGURE 55- ILLUSTRATION OF DIRECTIONAL LIGHT 

 

 

 

 

 

 

 

FIGURE 56- DIRECTIONAL LIGHT 

 

10.4.8 Spot Light  

The Spot Light   effect spots the light ray on to a particular specified position on the canvas. 
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FIGURE 57- SPOT LIGHT              

1. Target : Specifies the targeting position  

2. Position : Specifies the position of the light  

 

10.4.9 Point Light  

The Point Light   command enables you to spread light rays towards the drawing canvas from a 

specified position of the light.  

 

FIGURE 58- ILLUSTRATION OF POINT LIGHT 
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FIGURE 59- POINT LIGHT 

Deleting the Light Effects  

To delete any inserted light effect on the drawing canvas: 

1. Select the light effect you want to delete from the Lighting Window  

2. Click on the Delete Light  button  

 

Note: Select the Keep default light on check box on the bottom-left of the window to reset the light 

effects to the default settings.  

Shapes in the ScanMaster™ Designer 2D user manual for more on editing 2D shapes 
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11 3D PROCESS PREPARATION 

The final step before you mark your 3D model is the preparation of the 3D process. This chapter 

guides you on the process of preparing the 3D model for your laser marking.   

11.1 SURFACE MARKING PROCESS 

After you have created the 2D and 3D models you can start working on your 3D marking process. The 

surface marking options in ScanMaster™ Designer software are designed to mark 2D models on a 

non-uniform 3D surface. This software enables you to project or wrap a 2D model on to the 3D 

model.   

 

Note: Refer Appendix A for more details about the differences between the Projection and 

Wrapping features in 3D surface marking. 

 

1. To start a surface marking process, select the 3D model from the Project Explorer which you 

want to process 

2. Click on the Surface Marking   button on the Marking Processes panel of the Project 

tab 

 

FIGURE 60- SURFACE MARKING 

3. You will find the new surface marking process element on the Project Explorer once you 

create a surface marking process 
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FIGURE 61- SURFACE MARKING PROCESS 

4. If you click on the Surface Marking button before selecting the particular 3D model you will 

find the following Properties tab which will direct you to select the desired 3D model 

 

 

 

 

 

 

 

 

FIGURE 62- SURFACE MARKING PROPERTIES TAB 

5. The Properties tab allows you to select the appropriate 3D model from the given 3D Model 

List 

6. Click on the 3D Model List drop-down arrow to select the 3D model you want to process 

7. Move to the Model tab to proceed. Then you will see the surface marking 3D model that you 

selected. 
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11.1.1 Adding a 2D image 

To add the 2D image to the 3D model on the surface marking process:  

1. Click on the Add 2D Image  button on the Surface Marking panel of the 

SurfaceMarking tab 

 

FIGURE 63- ADD 2D IMAGE BUTTON 

2. You will find the following Add 2D Image dialog box 

 

FIGURE 64- ADD 2D IMAGE 

3. Select the appropriate 2D model from the 2D Image drop-down list  

4. Select the method you want to map the 2D model from the Surface Marking Method drop-

down list 

5. Select either Projection or Wrapping and click OK to confirm and proceed 
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11.2 GENERATE 3D SURFACE MARKING MODEL 

11.2.1 Placement of 2D Image 

You can apply transformations to the 2D image before you do the marking to obtain the correct 

position and scaling of the 2D image. ScanMaster™ Designer software allows you to Move, Scale and 

Rotate the 2D model to adjust and fix it to the 3D model according to your requirements.  

1.  

1. Click on the Shape Tree tab 

2. Select the desired 2D model 

You will be able to find the Properties panel in the right-bottom of the 

window  

11.2.2 Moving 2D Images 

You can use the options in the Move section of the Properties panel 

to move the 2D image into the desired place.  

The arrows as shown in the figure above, allow you to move the 2D 

image along the X and Y directions of the 2D image.  

You can use the Move 2D Image    command to move the 2D. Click 

and drag the mouse on the 2D image. Move 2D Image command 

functions only before you apply the 2D image to your 3D model.  

 

 

 

Note: The amount of units in which the 2D image moves at each click of the arrows will be as 

configured in the Moving Step option in the Miscellaneous 3D page of the Application Preferences 

wizard. 

 

 

FIGURE 65- PROPERTIES OF 2D IMAGE 



3D Process Preparation 

1040-0009 Revision  

11.2.3 Scaling 2D Images 

You can use the options in the Scale section of the Properties panel to scale the 2D image according 

to your requirements.  

The arrows  shown in the figure of the Properties tab in the previous page allow you to scale the 2D 

image along the X and Y directions of the 2D image.  

The options in the Base Point panel allow you to select a desired base point.  The selected base point 

will be kept fixed while you scale the 2D image.  

Check the Maintain Aspect Ratio option to keep the X and Y scale factors both similar.  

 

Note: The amount of units in which the 2D image scales at each click of the arrows will be as 

configured in the Scaling Percentage option in the Miscellaneous 3D page of the Application 

Preferences wizard. 

11.2.4 Rotating 2D Images 

You can use the options in the Rotation section of the Properties panel to rotate the 2D image to the 

desired angle.  

Specify the angle to be rotated on the Angle text box and select the desired anchor point from the 

Anchor Point panel.  The object will be rotated around the selected anchor point. 

You can use the Rotate clockwise and Rotate Anticlockwise buttons to rotate to the 2D image in the 

desired direction.  

11.2.5 Viewing Surface Marking Objects 

ScanMaster™ Designer software provides you various viewing options of the surface marking objects.  

You can find these options in the View panel of the SurfaceMarking tab.  

 

FIGURE 66- VIEWING SURFACE MARKING OBJECTS 
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11.2.6 Shape and Mapped Image  

The Shape and Mapped Image  function allows you to view the 3D model and the mapped 2D 

image both on the drawing canvas.  

You will find this viewing option by default in a surface marking process.  

 

FIGURE 67- SHAPE AND MAPPED IMAGE 

11.2.7 Bounding Box and Shape  

The Bounding Box and Shape  function allows you to view the bounding box of the mapped 2D 

image along with the 3D model.  

This feature efficiently adjusts a 2D image especially when you handle complex models. 

 

FIGURE 68- BOUNDING BOX AND SHAPE 
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11.2.8 Mapped Image Only  

The Mapped Image Only   function allows you to view only the mapped image on the drawing 

canvas.  

 

FIGURE 69- MAPPED IMAGE ONLY 

11.2.9 Running the surface marking project 

Once the surface marking process is configured you can proceed to laser marking. The ScanMaster™ 

Designer provides a very flexible way of managing and controlling the laser marking processes through 

the script object of the project.  

By default, the script will contain a single command to laser mark all the objects in the project tree. To 

run only the surface marking process, simply delete the default “ScanAll()” command and insert 

<ScriptVariableName>.Start() command to the script. The command starts with the surface marking 

object name and followed by a “.Start()” command.  For example, to start “SurfaceMarking1” object 

simply insert SurfaceMarking1.Start() command to the script.  
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11.3 ENGRAVING PROCESS 

Engraving is the process of implementing any desired 3D model by removing material from a 3D 

object. The process of engraving in ScanMaster™ Designer software enables you to do a laser 

engraving project.  

11.3.1 Create an Engraving Process 

To create an engraving, click the Engraving command on the Marking Processes panel of the 

Project tab  
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FIGURE 70- ADD ENGRAVING MODEL WIZARD 

1. Click the 3D Model List drop-down arrow to select the 3D model that you want to perform 

the engraving 

2. Specify the settings of the sections and hatching styles of the engraving process.  
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FIGURE 70- SECTIONING OPTIONS 

The Sections refers to a collection of layers in the engraving 3D model.  Initially the 3D model is in a 

single section. You can split the 3D model into different sections if required. Dividing the 3D model 

into different sections is useful when there are variations in the properties of the materials, across 

the cross-section of the 3D model.  

The number of layers in a section affects the quality of the output. The number of layers in a section 

depends on the materials. The harder the material, higher the number of layers should be.  

You can specify the properties of the section(s) from the Sectioning options wizard.  

To add a new Section:  

1. Click on the Add Section   button on the Sections panel 

To change the properties of the Section:  

1. Specify the Minimum Z value of the section. The Minimum Z and Maximum Z values define 

the total Z range of the section by specifying the top-most and bottom-most values 

2. Select either Number of Layers or Layer gap to specify the number of layers in which the 

engraving will be processed 

3. Select a color for different sections so that you can identify the difference of the applied 

sections 

4. Click the Delete Section   button to delete any sections from the process 

5. Add a hatching style from the given Hatch styles in the Hatching panel 

6. Specify the properties of the Hatching styles 

7. Click the Delete Hatch   button to delete a Hatch 

8. Click Finish  
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Note: Refer the ScanMaster™ Designer 2D user manual Hatch Operations in Chapter 8 Shape 

Operations, for more    details on specifying the Hatching Styles. 

 

FIGURE 17- SECTIONS AND LAYERS OF ENGRAVING 

11.3.2 Modify an Engraving 

From the Properties tab engraving properties can be changed even after creating the Engraving 

process. The changes made through the properties tab will be added while navigating back to 

Engraving View. 
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FIGURE 73-  ENGRAVING PROPERTIES 

 

11.3.3 Modify a Section 

You can also change the properties of the hatching styles and the colors of the sections.   

1. Select the section(s) from the Engraved Layers tab 
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FIGURE 74- ENGRAVING PROCESS TREE 

2. Edit the properties of the section from the options in the Properties panel below the 

Engraved Layers 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 75- SECTION PROPERTIES 

3. Click on the Update Engraving button to confirm the changes.  
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11.3.4 Viewing Engraved Objects  

The options in the Viewing Engraved Objects panel of the Processed Model tab are featured in a 

way that enables you to view the engraved objects in three different styles.  

The Boundary Only  function allows you to view only the boundary of the engraving sections  

The Hatch Only  function allows you to view only the hatch applied to the 3D shape.  

The Boundary and Hatch  function allows you to view both the boundary and the hatch of the 

3D shape which is to be engraved.  

 

 

 

 

 

 

 

FIGURE 76- VIEWING ENGRAVED OBJECTS 

11.3.5 Engraving Simulations 

After you have specified the sections of your engraving process you can preview the engraving 

process using the options in the Engraving Simulations panel of the  Processed Model tab.  

 

FIGURE 77- ENGRAVING SIMULATIONS 

1. Select the desired section(s) from the Engraved Layers tab.  
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2. Click on the Start   button to see the order of the engraving process 

3. Click the Stop   to stop the simulation 

The simulation will depend on your selection of the section(s) from the Engraved layers tab.   

If you want to preview the whole 3D model engraving process select the engraving process from the 

Engraved Layers tab, or select the desired section only to view the simulation of that particular 

section only.  

11.3.6 Running the Engraving project 

Once the engraving process is configured you can proceed to laser marking. The ScanMaster™ Designer 

provides a very flexible way of managing and controlling the laser marking processes through the script 

object of the project.  

By default, the script will contain a single command to laser mark all the objects in the project tree. To 

run only the engraving process, simply delete the default “ScanAll()” command and insert 

<ScriptVariableName>.Start() command to the script. The command starts with the engraving object 

name and followed by a “.Start()” command.  For example, to start “Engraving1” object simply insert 

Engraving1.Start() command to the script.  

11.4 SAMPLE SURFACE MARKING 

In this section you will be provided an example considering a simple scenario in 3D surface marking 

process.  

Scenario: Create a model of a pipe, project and wrap a text ScanMaster to the internal surface of the 

pipe.  

To try this sample you need to : 

1. Start ScanMaster™ Designer 

2. Create the 3D Model  

3. Modify the 3D Model 

4. Transform the 3D Model 

5. Create the 2D Model 

6. Change the Viewing Orientation 

7. Process 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Completed%20Manuals/ScanMaster™_Designer_1#_Starting_
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8. Edit the 2D Model 

11.4.1 Starting ScanMaster™ Designer    

1. Click Start | Programs | CTI | ScanMaster™ Designer 

2. Click New| New 3D Project 

11.4.2 Create the 3D model  

1. To insert a cylinder shape to the drawing canvas click on the Cylinder command on the 

Basic panel of the Home tab. 

2. Specify the Radius and Height of the Cylinder 

3. Click OK 

 

 

 

 

 

 

 

FIGURE 78- CYLINDER ON THE CANVAS 

4. To insert a box shape click on the Box  command on the Basic panel of the Home tab 

5. Specify the Base Point, Width, Height and Length of the Box 

6. Click OK 
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FIGURE 79- BOX SHAPE ON THE CANVAS 

11.4.3 Modify the 3D model  

1. Select both the shapes  

Note: Select the Cylinder shape initially and then select the Box shape as you are about to cut the 

Cylinder using the Box shape. 

2. Click Cut  from the Boolean Operations panel of the Modeling tab 

 

FIGURE 80- EDITED CYLINDER 

3. Insert another Cylinder  shape 

4. Specify the Radius and Height of the Cylinder 

5. Click OK 
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FIGURE 81- THE TWO CYLINDERS 

6. Select both shapes 

7. Click Cut  from the Boolean Operations panel of the Modeling tab 

The result will be as shown in the figure below.  

 

FIGURE 82- THE EDITED CYLINDER 

11.4.4 Transform the 3D Model  

Rotate 

1. Select the 3D model  

2. Click on the Rotate option in the Transformations panel of the Modeling tab 

3. Specify the Standard Axis and the Angle to be rotated 
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FIGURE 83- ROTATING PARAMETERS 

Move to Origin  

1. Click the Move To Origin button in the Transformations 

2. Select the Center of Bottom option from the list  

11.4.5 Create the 2D Image  

1. Click the 2D image that is already added to the project by default 

2. Click the Insert Text button 

 

FIGURE 84- TEXT EDITOR 

3. Specify the Text Height and press Enter 
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4. Type “ScanMaster” as the text 

5. Click OK 

 

FIGURE 85- 2D IMAGE 

11.4.6 Change the Viewing Orientation 

Before you start the process change the viewing orientation to Top in order to make your work much 

easier. 

1. Click View Orientation button on the View panel 

2. Select Top from the View Orientation list 

 

FIGURE 86- TOP ORIENTATION 
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11.4.7 Process 

To do a Projection:  

1. Click the Surface Marking  button from the Processes panel of the Home tab 

2. Select the Surface Marking1 process from the Project Explorer tab 

Click the Add 2D Image  button on the Surface Marking panel of the Processed Model tab 

 

FIGURE 87- ADD 2D IMAGE 

1. Select the 2D Model 1 

2. Select Projection from the Surface Marking Method drop-down menu 

3. Click OK 
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11.4.8 Edit the 2D Image 

1. Select the Shape Tree tab 

2. Select the 2D Model 1 

3. Select the Properties tab of the Shape Tree 

4. Check the Maintain Aspect Ratio check box 

5. Scale down the 2D image across the X axis to adjust according to the 3D model 

6. Click on the Apply  button to project the 2D image to the 3D model 

 

FIGURE 88- APPLY PROJECTION 

To do a Wrapping: 

1. Click Add 2D Image  button on the Surface Marking panel of the Processed Model 

tab 

2. Select the 2D Model 1 

3. Select Wrapping from the Surface Marking Method drop-down menu 

4. Select the desired face of the 3D model where you need to wrap the 2D image 
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FIGURE 89- SELECT THE DESIRED FACE 

5. Click Ok. 

6. Adjust using the Scale and Move functions in the Properties panel 

7. Click Apply   button to wrap the 2D image to the 3D model  

 

2.  

FIGURE 90- PROJECTION AND WRAPPING 
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11.5 SAMPLE ENGRAVING 

In this section you will find a sample engraving process performed using ScanMaster™ Designer 

software. The expected output of this sample scenario is to create a physical logo using a work piece 

of two metals including aluminum and brass.  

 

FIGURE 91- PREDESIGNED ENGRAVING MODEL 

Assume that you have a cylindrical work piece with a combination of two metal layers as aluminum 

and brass. To create this physical logo you need to remove the unnecessary sections by engraving.  

For you to get this output you have to create an appropriate mold that tells the system which parts 

to be engraved and which parts are not to be engraved. The mold should consist only the sections 

that needs to be engraved. A predesigned 3D model which looks exactly as the actual output will be 

required to extract some sections from the mold which are not supposed to be engraved.  

The ultimate result of this process should remain a “S” shape on the aluminum layers and make two 

screw holes in the brass layer. 

Refer the following sections to check how this sample engraving can be performed using ScanMaster 

Designer 3D Extension. 

To try this sample you need to: 

1. Open ScanMaster™ Designer 3D project 
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2. Create the mold 

3. Modify the model 

4. Prepare the engraving process 

5. Check the engraving simulation 

 

11.5.1 Open ScanMaster™ Designer 3D Project 

1. Click Start | Programs | CTI | ScanMaster™ Designer  

2. Click New 

Note: Check the Before You Begin section of this document to revise the facts that you should keep 

in mind when handling a 3D project using ScanMaster™ Designer. 

11.5.2 Create the Mold  

3. The aim of creating this mold is to extract an appropriate virtual model that allows you to engrave 

the desired structure on the original material.  

4.  

5. Import the predesigned 3D model: 

1. Go to Project Ribbon tab.  

2. Select 3D model   button from the import  drop down button. 

3. Click the Move to Origin | Center of Bottom option of the transformations panel if required.  

6.  7.  

To insert a cylinder:  

file:///D:/SVN/CTI/Trunk/User%20Manuals/SMD3D/ScanMasterDesigner3DExtension.docx%23_Before_You_begin
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1. Insert a Cylinder from the Basic panel of the Home tab.  

2. Define the Radius and Height as 12.6 and 5 

             

FIGURE 92- INSERTED CYLINDER 

 

11.5.3 Modify the Mold 

8. Make sure that you have moved both the models to the origin of the drawing canvas.  

Note: The cylinder shape is inserted to the origin of the drawing canvas by default and the imported 

model should be moved to the origin. Both models will be place in the same position of the canvas in 

order to perform the Boolean Operation.  

9.  

1. Select the two models. First select the Cylinder and then the imported 3D model. 

2. Click Cut command in the Boolean Operations panel of the Modeling tab.  

The figure below shows the mold that was created.  
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FIGURE 93- MODIFIED IMAGE IN DIFFERENT VIEW ORIENTATIONS 

11.5.4 Prepare for the Engraving Process 

The next step in this scenario is to prepare the model for the engraving process.  

1. Click the Engraving  command on the Marking Processes panel of the Project tab 

 

FIGURE 94- SPECIFICATIONS OF SECTION 1 
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2. Specify the Minimum Z of Section 1 as 2.4.   

Note: The height of the sections depends on the heights of the two materials. Measure the height of 

the original materials and specify the heights of the sections respectively.  

3. Define appropriate number of layers to each section depending on the materials of the 

sections.  

4. Insert a desired type of hatch for both of the sections from the given hatching styles  

5. Click Finish  

 

FIGURE 95- ENGRAVING LAYERS AND SECTIONS OF THE 3D MODEL 

11.5.5 Check the Engraving Simulation 

After you specified the parameters for your engraving process you can use the Engraving Simulation 

commands to view the simulation and make adjustments if needed.   

1. Click Start command of the Processed Model | Engraving Simulation panel to view the 

engraving simulation                                                                                                                                                                                                                                                                                                                                                                                                                            

2. Click Stop command to stop the simulation 
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12  APPENDIX A 

12.1 SURFACE MARKING 

Surface marking is one of the available 3D scanning processes. Surface Marking in 3D scanning 

projects refers to mapping a 2D image to a 3D surface there by obtaining a quality 3D marking. 

ScanMaster™ Designer provides you features that enable you to do surface markings in two different 

styles.  

1. Projection  

2. Wrapping 

Multiple 2D images can be projected or wrapped to a 3D model in different viewpoints according to 

the users requirements.  

12.1.1 Projection  

Projection is used to project a 2D image to a 3D surface. Projection in 3D surface marking refers to 

mapping a 2D image to a 3D surface in a way that the resulting 3D image will be undistorted when 

viewing in the direction of the projection. If you view the projected image in a different direction you 

will see that the edges of the image have extended beyond the border or line.  
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FIGURE 96- PROJECTION 

12.1.2 Wrapping 

This technology is used to wrap a 2D image to a 3D surface. Wrapping in 3D surface marking refers to 

mapping a 2D image in a way that the resulting image will have the minimum distortion locally when 

viewed in any direction.  
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FIGURE 97- WRAPPING 
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13 APPENDIX B  

 

13.1 SPECIFYING THE AXES 

Most of the functions in ScanMaster™ Designer allow you to select the Standard Axis or the 

Arbitrary Axis. This section will help you to understand the difference between the standard axes 

and the arbitrary axes.  

13.1.1 Standard Axis  

The standard axes are defined by the X, Y and Z values as you see in the figure below.  These axes 

refer to the normal axes to define the position on the drawing canvas.  
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FIGURE 98- STANDARD AXES 

 

13.1.2 Arbitrary Axis  

To define the Arbitrary Axis you can specify in two ways. You specify either the Point and Vector or 

the Two Points.   

Point and Vector can be used in situations where you want to specify a position and the vector or the 

direction from that point onwards  
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FIGURE 99- ARBITRARY AXES – POINT AND VECTOR 

 

Two Points can be used in situations where you want to specify two points to define a direction 

across the defined two points which includes the starting points and the end points on the drawing 

canvas.   

 

FIGURE 100- ARBITRARY AXES - TWO POINTS 



Index 

1040-0009 Revision  

14 INDEX 

 

3D Model List, 74 
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